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Hello my friend, and welcome to my Trading Simulator user guide!

Well, you must be wondering what it's all about and how can | surprise
you, so let's dive right in:

The Trading Simulator is software that my team of programmers built to
my request. It enables you to test any strategy, exercise your trading,
find out how to improve strategies and even invent new strategies.

Yes, that's right... and in a minute I'll explain how to use it.

Ideas - how to use my simulator

e If you've just learned a new trading system, looking at historical
charts and finding setups in hindsight is not the way to go...
Use the simulator to see true market action, and practice the
strategy's decision-making without relying on hindsight, which will of
course not help you when coming later to trade it live...

e Practicing your live trading: as you know, one of the biggest
problems for traders, is the live entry. Any beginner and sometimes
even veterans, might get "cold feet" when it comes to entering a
trade. That's why you have this simulator right now. Practice any
market condition, and improve yourself and your confidence at the
decision making process.

e Practice your trading psychology: another area where many traders
suffer is the live trading psychology. Most traders, especially at the
beginning, find it difficult to let the trade work, and tend to close the
trade not according the rules. And because of that, traders cut profits
too fast, and do not cut losses on time.

That's exactly the reason why you need the simulator. Practice many
trades as their results unfold, the entries and the exits, until you feel

that no market condition negatively affects your psychology.




...continued - ideas on how to use my simulator:

In my Forex Signals & Mentoring service, my members can request
Indicator and Robot development for free, and this simulator will
hopefully help members in refining their strategy ideas.

Moreover, when you develop your own strategy, or if you wish to
add rules to an existing strategy, testing it on live market means you'll
have to sit on wait, sometimes for complete days or weeks, for just
one setup to materialize! That's of course not very efficient.

Use the simulator to fast-forward the market action and quickly see
your trading ideas unfold.

Find the market's "behind the scenes": everyone knows that markets
constantly change their character. For example July, August and
some of September can be less volatile than other months.

Now you have the chance to see market action and character quickly
change and unfold, and see how your strategy works in the
"problematic” zones, and how you as trader can succeed even in such
situations.




So let's begin with installing the simulator. Just do the following:
1.1f your MetaTrader is open, close it.

2. Copy the file you downloaded, into MetaTrader's experts folder.
The file is named: Vladimirs_Trading_Simulator_1TP_v1.00.ex4

[ . » Computer » Local Disk (C:) » MetaTraderd » FXCM-02 » experts »

'y

fit View Tools Help

e v | | Open = Burn New folder
! Name : Date modified Type \ Size
] | config 03/04/2011 10:58 File folder
K Ju files 24/03/2011 11:06 File folder
] L include 24/03/2011 11:05 File folder
| indicators 29/04/2011 11:31 File folder
3 L. libraries 28/04,/2011 00:26 File folder
J | logs 05/05/2011 09:14 File folder
b )i presets 24/03/2011 11:06 File folder
3 | samples 24/03/2011 11:05 File folder
! ). scripts 29/04/2011 11:31 File folder
| templates 24/03/2011 11:05 File folder
y ] 02.ext 24/03/2011 11:06 EX4 File 6 KB
|| MACD Sample.exd 24/03/2011 11:06 EX4 File 6 KB
' @ MACD Sample.mgd 15/10/2007 15:47 MetaQuotes Lang... 6 KB
- || Moving Average.exd 24/03/2011 11:06 EX4 File SKB
k @ Moving Average.mgd 15/10/2007 15:47 MetaQuotes Lang... S5KB
|| mglcache.dat 28/04/2011 00:26 DAT File 2KB
| | Vladimirs_Trading_Simulator 1TP_v1.00.exd 19/06/2011 11:50 EX4 File 16 KB

That's all! Now open your MetaTrader.

From the Tools menu, choose Options, and make sure the following
boxes are ticked and un-ticked EXCATLY as they appear in this screen
shot:

| Server I Charts I Objects | Trade | Expert Advisors | Email | Publisher | Evants|

Enable Expert Advisors (except for Custom Indicators and Scripts)
Disable experts when the account has been changed
Digable experts when the profile has been changed

Allow live trading
[ Ask manual corfimation

Allow DLL imports
[] Corfirm DLL function calls

Allow extemal experts imports

[ ok [ canced |[ Hep |




The simulator works on backtest, with what's called "Visual Mode", so
you need to open MetaTrader's strategy tester: From the View menu,
choose Strategy Tester.

When you have MetaTrader's Strategy Tester open, from the Expert
Advisors drop-down box, choose "Vladimir's Trading Simulator":

=

Expert Advisor: [‘u"ladimirs_TlElding_SimuIator_‘ITP_\r‘I .00, Copyright © 2011, www \adimirForexSignals

-

Expert pmpen@

Optimization

Symbol: [EURCHF, Euro vs Swiss Franc =] Period:| Hé -
Model: [E\rer)'tick {the most precise method based on all available least timefi V]
Use date |v From: 20100808 To: 2010.05.01 -
Visual mode v 11 Skip to 20110619 =

Symbol properties
Open chart

Modify expert

Start

5
E Settings | Journal |

Imagine it this way: instead of a robot test, this is now a human testing
ANY strategy in the past! Sounds amazing? That's just the beginning.

To make sure you test it correct, all you have to do is create the
template you want to test on your charts, and call this template with the

same name as the simulator EA, which is called:

Vladimirs_Trading_Simulator_1TP_v1.00

Now, tick the box next to "Visual Mode" (because we are going to test
on the past) and choose the date range you want to test:

x

Expert Advisor: [\l"Iadimirs_TlElding_SimuIator_‘ITP_\r‘I .00, Copyright © 2011, www . MadimirForexSignals

7

Symbol: | EURCHF. Euro vs Swiss Franc -

Model: [Everytick {the most precise method based on all available least timefi v]

Use date |v From: 20100808 To: 2010.05.01 R

T Skipto 20110619

Optimization

Expert properties
Symbol properties
Open chart

Modify expert

ol
E Settings | Journal |




Click the Expert properties button, and choose the initial Stop Loss, Take
Profit and the lot size you want your trades be opened with.

| &R 00 || e e e e e e e aes (e sl e | el e e e | L T
Vladimirs_Trading_Simulator_1TP_v1.00
| | [Testing | Inputs | Optimization | o
7 ~
'|—0 Variable
xd
™ Stop Loss Pips Expert properties
[T Lots Size = T
Iptimization Open chart
Modify expert
[ Load ] [ Save ]
5 B Star
B [ ok ][ cancel |[ Resst |
ol | Itk 440 kb

When finished, click OK then click the Start button.

Now you should see a new chart opened, with the strategy template of
the strategy you wish to test.

The button on the bottom right corner should change from "Start" to
"StOp".

If the button still displays "Start", and you get a "Waiting for update"
message on the chart, it means you do not have enough history data to
test on, or you specified incorrect start and end dates to test. In this
case, go to the Tools menu, then choose History Center:

. . e

Tcmls| Window  Help

Mew Order F9
Histony Center F2
Global Variables F3

MetaQuotes Language Editor F4

o '\'Ff> EE' E ﬂ

Oiptions Ctr+0




Here you'll be able to download historical data for your test:

I

History Center: EURCHF, M1

Symbols: Database: 2672 records
""" &) AUDIPY = || Time Open High Law Close volume
""" 1 AUDNZD @ 2011.04.23 08:01 1.29300 1.29300 1.29204 120204 3
----- %] aubusD
[J 2011.04.28 08:00 1.29297 1.29304 1.29294 1.29300 34
..... %] CADCHF
_____ 3) CADPY 3 [J 2011.04.2807:59 129294 1.29306 1.29287 129296 k)
..... 3 CHEIPY [] 2011.04.2307:58 1.29273 1.29305 1.29273 120204 2
..... %] CHFNOK [] 2011.04.2807:57 1.29269 1.29293 1.29266 1.29274 28
..... %] CHFSEK @ 2011.04.23 07:56 1.20263 1.20269 1,20260 1.20266 ct}
..... %] EURAUD [] 2011.04.2307:55 1.29243 1.29266 1.29245 1.29265 3
El @ 2011.04.2807:54 1.29264 1.29270 1.29243 1.29252 37
<"T“""$ ELRCHF [ 2011.04.78 07:53 1.29247 1.29259 1.29247 1.29264 16
. @ 2011.04.2807:52 1.29280 1.29290 1.20244 1.20247 4
! [J 2011.04.28 07:51 1.29270 1.29293 1.29268 1.29277 35
----- 15 Minutes (M15)
_____ 30 Minutes (M30) @ 2011.04.2307:50 1.29281 120234 120244 1.20263 &6
_____ 1 Hour (H1) [J 2011.04.28 07:49 1.29276 1.29327 1.29276 1.29281 51
..... 4 Hours (H4) @ 2011.04.2307:48 1.29322 1.29334 1.29260 129275 40
..... Daily (D1) @ 2011.04.2807:47 1.29331 1.29334 129328 122323 18
----- Weekly (W) @ 2011.04.2807:46 1.29337 1.29341 1.29312 129331 37
----- Monthly (MN) [ 2011.04.28 07:45 1.29336 1.29340 1.29320 1,29333 57
&l EoeTe - i
| ( Download 3 | | Add | | Edit | | Delete | | Export | | Import | Close ]

Assuming you have the historical data downloaded, and you clicked the

Start button, you now see the simulator along with your startegy's

template:

U H4 81,485 81,486 B1.449 B1.457
|
Vladimir's Trading Simulator 1.0
www. VIadimirForexSignals.com
Trading Hotkeys:
B
CLOSE TRADE: Shift+C
Simulator Info:
Lot Size: 0.10
Stop Loss Pips: 70.00
Take Profit Pips: 70.00
Open P/L in Dellars: 0.00
| Open PIL in Pips: 0.0
Total P/L in Dollars: 0.00
Total PIL in Pips: 0.0

A 0.0559

Skip to

20110615

-

-0.8151
0.3353

£0.3425

esker

For Help, press F1 Drefault

@||_Settings | Results | Graph | Report

(O 81.559 H: 81.754

L:81.551

(C: 81.596

W 4043

44/0 kb




You can play with the speed with which the market prices unfold, by
dragging the bar here:

= Expert Advisor: | Viadimirs_Trading_Simulator_1TP_v1.00, Copyright © 2011, www VadimirForexSignals Expert properties
Symbol: | USDJPY, US Dollar vs Japanese Yen Period: | H4 Symbol properties
Model: | Every tick {he most precise method based on all available least timefre Optimization Open chart
Use date |v From: 2011.06.01 To: 2011.06.03 Modify expert
Visual mode |v ) Skip to 20110619 -
L | Stop
E Settings | Results | Graph | Report | Journal |

You can also click the | | button on the right, to momentarily pause the
chart (for example, if you want to change the stop loss of a trade, as |
explain later).

Now the fun begins.
You're all set, and ready to begin testing your strategy.

When the rules of the strategy are met, you open a trade. Imagine you
are trading live market; you have no idea what is going to happen.

You have the market as it is at the moment, and you need to decide
what to do.

So, when the rules met, buy or sell.

On your keyboard, press SHIFT+B to buy, SHIFT+S to sell, and if you don't
need to wait until your SL or TP are reached, you can close the trade at
any moment, by pressing SHIFT+C.

What you actually do is trading!!!

Yes, you trade in the past, but you have no idea how the market is going
to behave next and how will it look like. So this is just the best way to
practice or test a strategy.

As for this version (yes, we are working on developing a new version
with more options!) you have a fixed lot size and a single profit target.




However, you can still adjust both the profit target and the stop loss on
the move, as the trade progresses. For example, if a trade goes in your
favor and you'd like to move its Stop Loss price to above the trade's
entry point, to lock some of the profit, do the following:

1. On MetaTrader's toolbar, click the Horizontal Line tool:

File  View Inset Chats Toolz Window  Help
- - | & 525 [5 1 L,:-a, New Order (L) | Expert Advisors
A -l [ @ E oA %

Alternatively, from the Insert menu choose Lines, then Horizontal Line.

2. Place the line on the chart, at the location you'd like the new stop loss
price to be:

In this example, the old stop loss was around 80.75 and | placed the line
at 81.310 which will serve as the new stop loss price.



3. To finalize the action and have the simulator automatically change the
stop loss, right click on the line and choose Horizontal Line Properties:

| Horizontal Line properties. ..

Objects List

Delete
Delete Al Amows
Delete All Selected

Unselect Al
Unselect

4. Then, on the window that opens, instead of the Name that appears
there, input the letters: sl

Commen | Parameters | Visualization |

Mame: sl
Description:
Style: |l Fed A

[ Draw ohiect as background

5. If you'd like to input an accurate price for the stop loss, you can do so
in the Parameters tab:

Common | Parameters | Visualization

Value: 81 EEDIEES

6. If you'd like to change the take profit price as well, draw another line,
then input its name as: tp
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After clicking OK, you'll return to the chart and the new stop or profit
will be changed.

Tip: if you'd like to verify what happens with your trades, you can click

the Strategy Tester's Journal tab, to view status messages:

GEPUSD,H1 usDal

* Time Message |
A 20110619 14:24:20 2011.06.01 03:23 Vladimirs_Trading_Simulator_1TP_v1.00 USDJW,@@
A 2011.06.19 14:24:20 2011.06.01 03:23 Vladimirs_Trading_Simulator_1TP_v1.00 USDJPY,H4: modify #1 buy 0.10 USDIPY at 51.470 sk 1,300 tp: 52.170 ok
A 2011.0619 14:17:11 2011.06.01 02:51 Viadimirs_Trading_Simulator_1TP_v1.00 USDJPY H4: Buy ticket number 1 opened @81.47 SL=80.77 TP=82.17
A 20110619 14:17:11 2011.06.01 02:51 Viadimirs_Trading_Simulator_1TP_v1.00 USDJPY,H4: modify #1 buy 0.10 USDIPY at 81.470 sk 80.770 tp: 52.170 ok
A 20110619 14:17:11 2011.06.01 02:51 Vladimirs_Trading_Simulator_1TP_v1.00 USDJPY,H4: open #1 buy 0.10 USDJPY at 81.470 ok
A 2011.06.19 14:07:12 Vladimirs_Trading_Simulator_1TP w100 inputs: Take.Profit.Pips=70; Stop.Loss. Pips=70; Lots.Size=0.1;

_ A 2011.06.19 14:07:03 Viadimirs_Trading_Simulator_1TP v1.00: loaded successfully

= e ——

g Settings | Results | Graph | Repor€ | Journal | )

For Help, press F1 Default i 45/0 kb

On the top left of the chart, as the trade progresses, you can monitor its
profit and loss in pips and in dollars:

USDIPY, H1 0.913 80 0.912

Wladimir's Trading Simulator 1.0

wiww. VladimirForexSignals. com
Trading Hotkeys:
BLRY: Shift+B
CLOSE TRADE: Shift+C
Simulator Info:
Lot Size: 0.10
Stop Loss Pips: 20.00
Take Profit Pips: 50.00
COpen P/L in Dollars: 4.08
Open P/L in Pips:  3.30

piiie

H——

Total P/L in Dollars: §1.76
Total P/L in Pips:  50.00

When trades are closed, you can also see here the total profit and loss
for all closed trades, in both pips and dollars.
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If you click the Strategy Tester's Results tab, you will see the list of all

trades and all trading actions you took (closing, modifying stop loss, etc)
in this list:

=

# Time Type Order Size Price S/L T/P Profit Balance
[a 1 2011.06.01 00:10 sell 1 0.10 51.453
[a 2 2011.06.01 00:10 modify 1 010 §1.453 81653 80953
@ 3 2011.06.01 14:22 t/p 1 0.10 80953 81.653 80953 61.76 10081.76
[a 4 2011.06.01 18:10 buy 2 0.10 80.879
[a 5 2011.06.01 18:10 modify 2 010 30.879 30679 81.379
Settings | Results | Graph | Report | Journal |
And to view a statistical report of your performance (once the test is
over!) click the Report tab.
Bars in test 1049 Ticks modelled 70104 Modelling quality 50.00% =
Mismatched charts errors 0 -
Initial deposit 1000000
Total net profit 72.89 Gross profit 119.28 Gross loss 46,39
Profit factor 2.57  Expected payoff 14.58
Absolute drawdown 2832 Mazximal drawdown 79.04 [0.78%) Relative drawdown 0.78% [79.04} |=
Total trades 5 Short positions [won %) 1 (100.00%) Long positions fwon %) 4 (50.00%)
Profit trades [ of total) 3 [60.00%) Loss trades (% of total) 2 (40.00%)
Largest profit trade 61.85 loss trade -37.25
Average profit trade 39.76 loss trade -23.20
Maximum consecutive wins (profit in mo.., 2(98.04) consecutive losses (loss in mo.., 24639
Maximal consecutive profit ([count of wi... 95.04 (2] consecutive loss [count of loss.. 4639 (2) -

Tester

Settings | Results | Graph | Repert | Journal |

In the next version, | will add many more options and cool features.

For those of you who know me, you know to expect many many

surprises!

Now with my simulator, you can better your trading skills, quickly and

easily learn new strategies, and even develop your own rules and

systems.

Enjoy, profit, test, and share if you have good things ©

To your success!!!

Vladimen Ribatkou
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